MSPS Fall Conference - Accuracy Course

Before beginning, establish an Internet connection via the WiFi indicator on the tablet:

5 4 o 10:36 AM
0 em P 10/6/2022 o

NOTE: If you plan to use a network rover for this exercise, obtain proper credentials as available at
https://gpsweb3.modot.mo.gov/. It may take an hour or longer for the credentials to be generated.

Startup/Control File Creation

1. Locate the Carlson SurvPC icon on the tablet desktop and double-tap to launch the application:

(B

Carlson
SurvPC
NOTE: Throughout this guide, the SurvPC 7 interface will be shown with variants as found in SurvPC 6 cited where
necessary.
2. Presuming you have the 15-point evaluation version of SurvPC installed, accept any alerts or indications (there may be
three of them) as you progress into the software:

T JOB:NEWIJOB

Unable to retrieve system or registration information!
The software will continue from this point to run in POINT BASED LIMITED
DEMO mode.

Each coordinate file will be limited to a maximum of 15 points.

5 Feature Code List : 0 Exit I}

3. Our first main task will be to create what will become a "control" ("CTRL" for short) job file. Tap Select New/Existing
Job:




Continue Last Job

Select New/Existing Job

NOTE: If time-constraints are an issue, the Control file we're about to create below can be downloaded from the Internet

by visiting:

https://web.carlsonsw.com/owncloud/index.php/s/cMNjk3bXhAg2vlq (password msps2022). Upon downloading and

specifying this file as the file to open, you may skip to the List Points discussion below.

4. Tap into the Name field and supply a Control Job name as illustrated below and tap Green Check when ready:
.. Coordinate Files K =

Type:

CRD/CF W | Drive: C v

P C:\Carlson Projects\Data\

P Backup

P geoids

P DOTCodes

P SurvPCScripts
Newlob.crd

Name:

MSPS2022-Ctr] - [JEsri RT

NOTE: "Green Check" is used throughout the application as the OK/Accept button. For commands below that have a
Green Check button, tap this button to implement the instructions unless otherwise noted.

5. Approximate positions of the "ground control" points have been provided in Lat/Long positions in Decimal degree
(d.dddddd) format and we ultimately want State Plane coordinates as indicated below (but do not tap Green Check at this



time):

.. Job Settings \/ x

New Job

Format

Options

Distance: US Survey Feet v | -——

:Z::;;:I:y Decimal Feet v

Angle: Degrees, Minutes, Seconds v | Time: Local v
[ Lat/Lon: Decir'rmlDegrees=‘F]Date: MM/DD/YYYY ¥

Zern North

Geoid: ContinentalUS_NGS2018.gsb

Projection: USA/NAD83(2011)/Missouri (East)

6. Continue to review settings and activate the Options tab as shown below:

" .. Job Settings

New Job System

[ JUse Control File

Select File

-\/ Create new jobs in folders a
v |Time Stamp Each Point |
Note GPS Scale factor per point
v |Store GPS Accuracy in Raw File

ke gl A el e e pa et B g ey A R el A L LN o s e J R n N e p g h g A b B R B e e s

7. When applicable Job Settings have been established, tap Green Check.
NOTE: You can always return to these settings via the File tab of the SurvPC main menu and tapping button #2 - Job
Settings.

8. Our next task will be to convert the approximate Lat/Long values of the Ground Control "course" targets into
approximate State Plane coordinates so we can use those coordinates to locate the targets. Locate the Calculator routine



as shown below:

™ JOB:MSPS2022-CTRL

File Equip §f Survey

| 1 Keyboard Input .‘ I 6 Station Store

2 Inverse 7 Transformation

8 Calculator

9 Manual Traverse |‘\
0 Point Average @

9. Activate the Conversion tab and set the values as suggested below:

.. Calculator X

Standard Scientific Generic

3 Areas i'a |

. L
4 Intersections ‘Q‘

.\
5 Point Projection a:

O M-Ft ODeg (Osb-HD I@ LLH-Grid I OAz-Br
Lat DD:; ® N O s Northing
38.70174167 -—-——
Lon DD: ® w O € Easting
90.44721111 ————
Hgt:  553.93 FELDE Hgt:
Save

Solve Lat/Lon Solve N/E \

[]Apply Localization [ ]Apply Geoid

official values.
10. Upon inputting the specified values (approximate elevation shown), calculate the coordinate and save as the designated
point number as illustrated below:



.. Calculator x

Standard Scientific Generic
O M-Ft O Deg (sb-HD @ LLH-Grid OAz-Br
Lat DD:; ® N O s Northing

38.70174167 1044367.59531
Lon DD: ® w O € Easting
90.44721111 835273.07339
Hgt:  553.93 RLiD: Hgt:  553.93
1
[ Solve Lat/Lon Solve N/E
[]Apply Localization [ ]Apply Geoid

11. Repeat for each of the course locations making sure to specify the designated point number prior to storing the point:

Show entries }
Title Category Address i
4
r " :
q PT#1 CARLSON 38.70174167, :
=, -90.44721111 i
{
Fl
r n o
4 PT# 2 CLAYTON 38.70166667, <
P -
o ', -90.44644722 ;
r " é
= PT# 3 SEILER 38.70077778, ;
N ’, -90.44721389 )
L
F

Fazs " "
4 PT# 4 SURDEX 38.70173611, j
o, 90.44818611 j
|
r | ‘
;M- PT# 5 SAM 38.70229444, 3
]
R -90.44923889 4
4
r b " i
‘ PT# 6 BEA 38.70279167, p-
?’ 1
R -90.44782222 g
r %) ;
40 PT# 7 STLTITLE 38.70220278, 3
:-*', -90.44694444 1
FYWY T AP SEITAPOURT R ST NI W PR NS N NPT PUOT S W YR TN VY W N N N R T

NOTE: Upon completion of all values, tap Red X to dismiss the Calculator routine.
12. Our next task will be to input the exact values of the Ground Control "control" targets as given State Plane coordinates
so we can use those coordinates to locate the targets. Locate the Keyboard Input routine as shown below:



7' JOB:MSPS2022-CTRL

File Equip || Survey Road BIM

1 Keyboard Input m | 6 Station Store U‘—: l
o T
' :

3 Areas ’a';

7 Transformation .

8 Calculator
9 Manual Traverse |‘\.

0 Point Average @
official values.

13. Upon inputting the specified values (suggested description shown), save the designated point number as illustrated
below:

.. Enter and Edit Coordinates ‘-

. L
4 Intersections ‘q‘

.\
5 Point Projection 4‘:

Type CRD: Alphanumeric
Point ID: 8
Northing: 1044906.4760
Easting: 834710.5580
Elevation: 533.9980
r’-—A_
Description: GCP /TWM o —
Prev | [ Next ] [ Utilities ]

NOTE: Tap the Next button to establish a new point.



14. Repeat for each of the control locations making sure to specify the designated point description prior to storing the point:

"E‘H‘ CP# 8 TWM 38.70322222, CLICK FOR OPUS
A, 190.44918056 SOLUTION - CP 8
OPUS-RS

MO-5P FT:
1.044,906.476 N,

834,710.558 E,
533.998 EL

”
Please consult with

"Q“: CP# 10 SEILER | hutpsi/istlsurveyer.org § 35 70209167, CLICK HERE FOR

’ /accuracy-course/
o, -90.44751389 OPUS SOLUTION
for lastest and official - CP 10 OPUS-RS

control coordinates!

'4-' ‘ CP#9 38.70120833, CLICK HERE FOR
ad, SURVEYORS 190.44758611 OPUS SOLUTION
MATERIALS - CP 9 OPUS-RS

S, b A, o B b A by i AR ot ol e Ao b AL L AR Ahh, A A AR A A




15. Let's review what we've established thus far. Locate the Points routine as shown below:

7 JOB:MSPS2022-CTRL

Road

Survey §| COGO BIM

Equip

2 Job Settings

(Easting(ft)  |Elevation(ft) |Description 'Rod Ht(ft)
1044367.60 835273.07 553.930 GCP /Carlson
1044340.41 835491.09 553.930 GCP
1044016.57 835272.48 553.930 GCP .
| Approximate Ground
1044365.41 834994.83 553.930 GCP Control Points as
located by Lat'Long
1044568.58 834694.28 553.930 GCP Conversion,
Elevations assumed.
1044749.88  835098.46  553.930 GCP
1044535.57 835349.08 553.930 GCP
1044906.48 834710.56 533.998 GCP /TWM -
4
Info ] | Edit Add Find Delete

Working Job Creation/Equipment Initialization

1. From the File tab, tap button / Job to create a new Job (this one to contain the locations you are measuring. Set a job
name as indicated by the course instructions:



.. Coordinate Files

Type: CRD/CF W | Drive: C v

P C:\Carlson Projects\Data\

P Backup Q Newlob.crd
PR DOTCodes

T geoids
B MSPS2022-Ctrl
PR SurvPCScripts

¥¥x¥ = Three-digit
L'Dhserver ID number

Name: MSPS2022-xxx.crd - [ JEsriRT

2. Continue with the review and establishment of any other settings making note to reference the previously created
Control file:

New Job System Format Stake

Use Control File

Select File C:\Car.. Prnjects\Data\MSPS2022-EtrI\MSPSZDZZ-CtrI.crd]

Create new jobs in folders -~

Time Stamp Each Point

Store GPS Accuracy in Raw File

v’
v’
Note GPS Scale factor per point
v’
v’

Auto Append Suffix to Base ID in Raw File

v |Use Feature Codes for Descriptions
I_/Iﬁ.___ll lalk Meedd Ml -

3. Our next task will be to establish communications with our desired field equipment. Locate the GPS Rover routine as
shown below:



7 JOB:MSPS2022-XXX

File Survey §I COGO Road BIM

| 1 Total Station *Q Il 6 Localization ; '
2 GPS Base ﬁ 7 Monitor/Skyplot

3 GPS Rover ‘f 8 Tolerances

4 GPS Raw Only T 9 Peripherals

5 Configure ;!:9 0 GPS Utilities

NOTE: If working with a traditional base/rover setup, you'll want to first use the GPS Base (similar setup instructions as

GPS Rover).
4. Establish the Manufacturer and Model for the equipment with which you will be working:

.. GPS Rover \/ x

Comms Receiver RTK
Manufacturer: |Car|son v o
Model: |BR>{? v

—_

Delete | | Defaults

Load | | Save I

Activate the Comms (Communications) tab.
5. If this is the initial setup for the equipment, establish the desired communication type (generally, Bluetooth) and tap the

"Wrenches" button as illustrated:



.. GPS Rover \/ X

Current Receiver RTK

Type: Bluetooth v

BT Type: Windows Mobile ﬂ gzh%

Device: v

PV _FTP I T VYW ey O PRE PR T Y LYW A E R T WEFTW I W e 7 LRy VA e TRrw W P S T WS WV

6. Look for the desired device (identifying information typically found on the field gear) as illustrated below:

Select Rover BT Device

Receiver Name Receiver ID Address PIN

Set Device PIN Set Device Name

7. Once the desired field gear item has been found (the Find Device may need to be run a second time in "noisy" Bluetooth
areas), select/highlight the device and tap Green Check:

.. Bluetooth Devices \/ x

Please select from these available devices:

DL12193

D2220710801230

B T N T N g o T v A T T Ty W VO T T YW YO e ey ey

8. The device will be added to the list of desired devices. Select/highlight the device and tap Bluetooth Connect: button to
pair the controller to the field equipment:




.. Bluetooth Devices

Select Rover BT Device

Receiver Name = ReceiverID | Address _ PIN

D2220710801230 D2220710801230/9¢:50:d1:e1:d1:65

N W TP T gy TN TRy S N N TR P e PR AT R T T WY VT Y N PRTTITR Y NN ey Y WY AT R YA

Upon a successful pairing, activate the Receiver tab.
9. Verify and set the desired values. NOTE: If using a metric-based pole height (typically as measured from the pole tip to
the bottom side of the receiver), you can indicate the metric value and apply a label (e.g. m = meters, mm = millimeters,
" =inches, ft = feet, efc) and even equations (e.g. 2m + 40mm) if additional items (e.g. quick-disconnects) are part of the
pole height. Switching focus from the field will compute the value in the customary units for the current job. Tap the
Advanced button for additional options available to your field gear:

.. GPS Rover ‘/ x

Current Comms Receiver RTK
Antenna Type: [BRX7 Internal] L1/L2/L5 In W T?Z @ vert
Oslant
Antenna Height: ft Abs. 70.1mm
Elevation Mask: 10 -
Position Rate: :5 Hz v |

14 Parameter Datum Advanced \

ey T LW W O W W W T Y R T R T T W P FT T T T T R R R N T Y T W N N T W YE_ETEN

10. Based on the field gear you're using, you may have options for additional accuracy checks as illustrated below:

[ JLog Raw Data to Receiver
Readings Per Point: 1

% Enable SureFix Audio Mode: Silent v

[]send file after config

No File Selected!

Configure NMEA Output JL Configure Constellations

h##ﬂmmuﬂmﬂdmalhl&
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11. Establish the RTK characteristics that the receiver will use to get its corrections:

.. GPS Rover
Current Comms Receiver
e 0
Device: Data Collector Internet v j_faﬂaf&l
Network: NTRIP v \
L T N o F g T rrv W Tr Fry W w1 Y T e T T Y LT W W PN WV W T _ T WO W ALY _FITN

NOTE: The following section presumes MoDOT VRS credentials have been established (you may register for the
service at https://gpsweb3.modot.mo.gov/).

12. If a desired NTRIP provider has not already been established, create a New set of NTRIP Broadcaster credentials as
illustrated below (make sure you provide your specific login credentials):

Name: MoVRS v l New [ Delete ]
IP addr: rtk3.modot.mo.gov Port: 2101
User: (Supply your MO VRS Cretlentials) Pwd: ¥k ok ok ok

LPTIr TR E T R TP ST S N rE R R T W T Y N N T E VU TR R W PR R N W T TRy Y P WY Tr v e v RN

13. Upon successful creation, authentication and accessing of the NTRIP Broadcaster, an available list of Bases will be
provided as illustrated below:

.. Bases for MoVRS \/ x

Name: VRS_RTCM31 v | New Delete
User Name: (your login name) Password: | ®#*****

Identifier: VRS RTCM31

Shortid: VRS_RTCM31

Type: GPS+GLO L1L2 Trimble Pivot Platform MoDOT

Format: [RTCM 3.1 1004(1),1005/1007(5),PBS(10) i
Paiitan: 38.35N 266.00E USA

Misc:

[v] Send Rover Position to Network

NOTE: It is generally advisable to utilize a Base in the following preferred order of availability:
1. RTCM 3.2: GPS (including L5)+GLO+GAL+BDS
2. RTCM 3.1: GPS+GLO
3. RTCM 2.3: GPS Only



14. Upon proper specification of the desired Base, review your applicable settings and accept the configuration:

.. GPS Rover \/ X

Current Comms Receiver

Device: Data Collector Internet v ﬁ%

Network: (e
NTRIP v| e

RTK Port: Data v

Message Type: iFtTCM V3.0 T

[JUse server transformations (ﬁ%

MoVRS: [VRS_RTCM31 “ 1

lv]Send Rover Position to Network

NOTE: Once set, these values will be retained as default values for subsequent uses of the equipment.

Equipment Configuration

1. Once complete, it is a recommended practice to ensure the receiver is able to obtain at least a Fixed GNSS solution prior
to performing any work. Tap the Monitor/Skyplot button as illustrated below to check the current GNSS status:

7 JOB:MSPS2022-XXX

File Survey || COGO Road BIM

1 Total Station *g | 6 Localization ; '

? 7 Monitor/Skyplot 17,

2 GPS Base

3 GPS Rover %ﬁ 8 Tolerances -ﬁ
4 GPS Raw Only Tl'ﬂ 9 Peripherals ED
) " -

2. Within Monitor/Skyplot, common items of interest include:
o Status: The accuracy solution of the receiver (should be Fixed or SureFixed)
o Latency: The age of the RTK correction (latency values greater than 5 seconds may indicate Internet connectivity
problems or radio interference issues)
o HRMS: Horizontal Root Mean Squared accuracy, 1-sigma (68%); essentially, expected horizontal error
o VRMS: Vertical Root Mean Squared accuracy, 1-sigma (68%); essentially, expected vertical error




.. 7 Monitor/Skyplot .

Position SATView SATInfo Ref
Status: FIXED Satellites: 23/25
Latency: 0.4s Local Elev: 650.1080ft
Base Selection: VRS_RTCM31
Local Northing: 1044368.5001ft
Local Easting: 835273.0707ft
HDOP: 1.10 VDOP: 2.10
X-Tilt: 0.02 PDOP: 2.37
Y-Tilt: ol Disconnect ] | Connect ]
Hrms: 0.043ft
Vrms: 0.104ft

3. Once a Fixed GNSS solution has been attained, let's set some other useful values. From the Main menu, tap Configure as
illustrated below:

7 JOB:MSPS2022-XXX

File Survey I COGO

1 Total Station *g | 6 Localization ; l

= 7 Monitor/Skyplot

=

3 GPS Rover mﬁ
4 GPS Raw Only Tl'ﬂ 9 Peripherals [}
=

2 GPS Base

)
!

8 Tolerances

!

2}




4. For the gathering of data to come, we'd like to record multiple measurements for a given point as illustrated below:

Coding Style

Prompt for Total Station Setup

v |Prompt for Height & Description

Prompt for Point Notes

No. of Readings to Avg -

Enter/Store Icon - TS:

View IMU Average GNSS
Classic v
Y
I_Iprnmn+ If Diinlicate nf Rark<iocht Ar | ast Readine (TS) L
Read & Store v
Read & Store v

Enter/Store Icon - RTS/GPS:

5. (Optional) Based on your desired use of correction for tilted-pole, indicate your preferred /MU (Inertial Measurement

Unit) settings (based on your field equipment):

.. Configure

General View

[v]View GNSS Level

Sensor Mode:

Incline Tolerance:

A e Ak S A dhn e e B gty e i et A R AL ik B A R A R e o g B e a0 G b A W o ol Jenethy g e iy

Average GNSS

v X

Correct for tilt

15.0

NOTE: In SurvPC 6.x and earlier, locate this feature under Equip — GPS Rover — Receiver tab:

(@ Ps Rover ( s
Current Comms Receiver RTK
Antenna Type: [BRX7 Internal] LYL2/LS In ¥ | [T iz @vert
‘.T—g_J OSIant
Antenna Height: 25 ft Abs. 70.1mim
Elevation Mask: 10
Position Rate: 5 Hz bl
[FTilt Features(imu) =il Oartx
r Advanced

6. As you are likely going to be averaging your measurements to obtain a coordinate, set/review the Average GNSS

settings:




General View IMU Average GNSS

Point Averaging Mode: From Raw Data v

[_]Beep on rejected measurements

[ ]Log Average Observations

[ ]Automatically accept average results

[]SurvNet duplicate point tag =

Coordinate Match Tolerance (3D) 0.098 ft

7. (Optional) Based on your desired use of correction for tilted-pole, you may want to perform an IMU Pole Calibration. If
so, tap on GPS Utilities as illustrated below:

7 JOB:MSPS2022-XXX

File Survey | COGO

1 Total Station *g | 6 Localization ; l
2 GPS Base = 7 Monitor/Skyplot @

mﬁ 8 Tolerances

9 Peripherals QD

!

3 GPS Rover

4 GPS Raw Only

0 GPS Utilities

5 Configure

I!



8. (Optional) Tap on Sensor Utilities as illustrated below:

.. GPS Utilities ‘_

Configure RTK Device Reset Factory Defaults Sensor Utilities
Network Connect Self Check GPS Raw Utilities

Network Disconnect Power Off Receiver Send Command
Hard Reset Reset RTK Engine Set Satellite Status

9. (Optional) Tap on IMU Pole Calibration as illustrated below:

IMU Pole Calibration

Verify e-bubble

One Point Sensor Test

NOTE: Refer to https://web.carlsonsw.com/files/knowledgebase/kbase05.php?action=display_topic&topic_id=1198 for
additional information regarding IMU calibration.

Measurement Tolerances and Aides



1. Our next task will be to review and set applicable Tolerances as accessed below:

7 JOB:MSPS2022-XXX

File Survey §I COGO

1 Total Station

3 GPS Rover

E 8 Tolerances
4] i
4 GPS Raw Only

5
3
i

i
!

9 Peripherals

5 Configure 0 GPS Utilities

i

2. Based on the brand/model of equipment, you will typically want to employ the highest Solution Type (aka Fix Quality)
as illustrated below:

.. Tolerances \/ x

Tolerance Profile General IMU
Min. Solution Type: SurefFix - Fr——— v
Hsdv Tolerance: 0.050 ft
Vsdv Tolerance: 0.075 ft
Latency Tolerance: 3.0 3
PDOP Tolerance: 3.500

Set other desired maximum tolerances as suggested above.



3. For the "locate" work to follow, the following General tolerance values can be set:

.. Tolerances \/ X

Tolerance Profile GPS IMU

Stakeout Tolerance: 1.000 Not suggested for | g
regular” work!

"Navigate To" Tolerance: 16.404 ft

Proximity Radius: 1.000 ft

4. (Optional) Review/set any desired /MU tolerances:

.. Tolerances \/ X

Tolerance Profile GPS General

Level Tolerance: 0.049 ft

Incline Tolerance: 15.0 i

NOTE: Upon completion of these desired tolerances, they can be saved into a named Tolerance Profile for quick re-use
in other similar projects.

5. (Optional) In the event you'd like to see background imagery (e.g. from on-line source such as Google to aid with
navigation), you might consider enabling the option through the use of the Map screen as illustrated below:



7 JOB:MSPS2022-XXX

1 Total Station

o - ﬁm
2 GPS Base A 7 Monitor/Skyplot ||
i

-
Tl'ﬂ 9 Peripherals ED
_

> 1l 0 Gps utilities T

g
[

6. While in the Map Screen, click on the 7o0/s menu as shown below:

g: FILE VIEW DRAW COGO TOOLS —--—

o

4 GPS Raw Only

5 Configure

Cmd: Layer: 0

G)‘ - 760 ft




7. Select the Web Map Overlays command as illustrated below:

. 7 MAP VIEW X
@: FILE VIEW DRAW COGO Centerline
A 3D Pline to PRO
cmd: La‘._.,'er: Ine 1o
& L 3D Pline Profile View
b

Convert Polylines to 2D

64‘ Edit

Trav/Inv/RadStk Defaults

@ Surface

_ Field to Finish
Q{)\ Image Overlays
B
& NGS Survey Mark Query

8. Set desired values (such as that from Google as suggested below:

Provider: Google v |
Layer: Satellite \ 4 (&_&J
Dimension: 512x512 v
Image Format: PNG v

[ JUse Reverse Graphic Screen style

Subject to Google Maps/Google Earth Additional Terms of Service
(https://www.google.com/help/terms_maps.html)

NOTE: For large coverage areas (being excessively "zoomed" out) or for slow/poor internet connection speeds, it may
take several seconds or minutes for the imagery to appear.

Locating Points

1. We should now have the basics established for the gathering of our data. Let's locate our course points and take readings
where we find them to be. Issue the Stake Points command as shown below:



7 JOB:MSPS2022-XXX

File Equip COGO Road BIM

| 1 Store Points ‘z I 6 Auto by Interval

2 Stake Points

7 Leveling

-
_-*f

2. We'd like to fetch the position of a desired and previously created point. Tap the Point List button as illustrated below:

.. Stake Points ‘/ X
Point ID: \ ’.\? | []Pt by Direction
Azimuth:

[]Obstructed Point

3. Since our desired point is housed within an external and referenced Control file, set the applicable Control source "radio
button" as found at the top of the dialog box as shown below:

.. Point Details ® ob O Control

Point ID Northing(ft) Easting(ft) _Elevatinn[ft]:Description :Point ID
G 1 1044367.60 835273.07 553.930 GCP /Carlson
& 2 1044340.41 835491.09 553.930 GCP

L R A R e Bt g e g g g A s R R g B BB oy R ok et By Ly e e A B e Bk gy g e g g B s b

Highlight/select the desired point from the list and tap Green Check.
4. You will be provided with relative directions on where the desired point is in relation to where the receiver is. Navigate
to the point and establish the GNSS receiver over the point when located:



.. NUSTKPT

@;‘ %1 Fixed
&
‘F“ x0301 'I rEEJ STK1 GCP /Carlson D @ 6.562 ft o

= N:1044367.5991ft E:835273.0814ft Z:650.0802ft O
{f Hrms:0.077ft Vrms:0.130ft PDOP:2.37 GDOP:3.10 TDOP:2.00 i'E}:L
%/ P:1 Z:553.930ft GCP /Carlson
Cut 96.150ft =i
South 0.004ft West 0.008ft 5

NOTE: Make sure to override the default Point Number with the pertinent point number syntax as provided for the
course. When ready, initiate readings with the "Store Point" button (data collector with red dot toward the upper right of
the interface).

5. Readings on the point will commence and results preliminarily displayed:

Status:FIXED Hrms:0.043ft
Latency: 0.1 Sats:23/25 PDOP: 2.4 Vrms:0.130ft
[ 22 of 60 measured

Average .Ei 23 Seconds -
N: 1044367.614 ft i Incline: - 0°0000"
E: 835273.094 ft 3 y
Z: 650.078 ft _ = &
H Range: 0.077 ft © e 113
Z Range: 0.060 ft % - N
HDev: 0.020 ft°
VDev: 0.019 ft & 0.06f 000  0.06R [ ] |
Pause




6. A summary of the results will be displayed. When comfortable, accept the result.

Pt: 1 Desc: GCP /Carlson
Northing(ft) Easting(ft) Elevation(ft)
Staked: 1044367.617 835273.067 650.082
Design: 1044367.595 835273.073 553.930
Move:  South:0.022ft East:0.006ft Cut 96.152ft [:;':::'::;?.114*3;1‘.‘::;:;y!]
VOff 1: ft  Elew: ft
VOff 2: ft  Elew: ft
Hrms:0.061ft Vrms:0.108ft PDOP:2.371
[V]Store Point Point ID: | XXX301 l
Point Description: STK1 GCP /Carlson Dist: 0.023ft =

7. Repeat the process by tapping the Green Arrow and establishing the next desired point.

Exporting Data

1. When all measurements have been completed, tap the Export button as shown below:

T JOB:MSPS2022-XXX

Equip §f Survey §} COGO

1 Job 6 Import

2 Job Settings 7 Export

3 Points .‘ 8 Delete Job

4 Raw Data -

5 Feature Code List E



2. Let's externalize our measurements to an external file. Tap the Export button as shown below:

Data Transfer

3. Let's save the coordinates to a Custom file format for further analysis.

.. Export \/ x

Export Coordinates v
File Type Text Report (*.txt) v
Format Custom v

[[]Email Report Address Book




4. Indicate the type of file to create (e.g. PN,E,Z,D file structure):
.. Export Ascii 3 v X

File Type: \User Defined B
Coordinate Order:

PT_ID,North,East,Elev,Desc v Config
Delimiter
@ Comma (O Space OTab (O other ”
Range: ALL Export []Point Notes
Other: [1Point Info
Precision: 0.0000 b i [J Attributes
Format Geodetic

5. Provide a meaningful file name as suggested below:

O asiifietowite ([l |
M|rive: C v D’

P C:\Carlson Projects\Data\MSPS2022-xxx\
P Backup

Name: MSPS2022-xxx.csv -

6. Attach a removable USB "jump" (or "thumb") drive to the data collector/controller (the operating system will likely
assign it a "D:" logical drive letter). Return to the Export button as shown below:




T JOB:MSPS2022-XXX

Equip §f Survey §| COGO Road BIM
1 Job 6 Import =3

2 Job Settings 7 Export
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4 Raw Data - 9 About Carlson SurvPC x64
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7. Let's transfer the current job to the external USB drive:

.. Export

I

Export |

Data Transfer




8. Set the appropriate destination folder and initiate the transfer of the job to the external drive/folder:

.. Data Transfer

I Manual Transfer

D:\MSPS2022\ =

e Copy Current Job to Folder \ Set Folder

Copy Job to Folder
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This completes the suggested exercise. As desired, exit from SurvPC via the File — Exit SurvPC button.



